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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard,
flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device
and the AC adapter comply with the user-accessible surface temperature limits defined by
the International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Computer models
equipped with an
AMD processor

Product Name

HP G4 Notebook PC

√

Processors

AMD® Fusion E-450 1.65-GHz processor
(dual core, 18 W)

√

AMD Fusion E-350 1.60-GHz processor
(dual core, 18 W)

√

AMD A8-3520M 2.50-GHz processor (1.6-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√

AMD A6-3420M 2.40-GHz processor (1.5-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√

AMD A4-3320M 2.60-GHz processor (2.0-GHz FSB,
4.0-MB L2 cache, dual core, 35 W)

√

AMD A4-3305M 2.50-GHz processor (1.9-GHz FSB,
2.0-MB L2 cache, dual core, 45 W)

√

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB,
4.0-MB L2 cache, dual core, 35 W)

√

AMD E2-3000M 2.40-GHz processor (1.8-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√

AMD Athlon II P360 2.30-GHz processor (1.0MB L2 cache, 1066-MHz, 3.2GT/sec, dual core, 25 W)

√

AMD Athlon II P340 2.20-GHz processor (1.0MB L2 cache, 1066-MHz, 3.2GT/sec, dual core, 25 W)

√

AMD Phenom II N970 2.20-GHz processor (2.0MB L2 cache, 1333-MHz, 3.6GT/sec, quad core, 35 W)

√

AMD Phenom II N870 2.30-GHz processor (1.5MB L2 cache, 1333-MHz, 3.6GT/sec, triple core, 35 W)

√

AMD Phenom II N850 2.20-GHz processor (1.5MB L2 cache, 1333-MHz, 3.6GT/sec, triple core, 35 W)

√

Computer models
equipped with an
Intel processor
√

1

Category

2

Description

Computer models
equipped with an
AMD processor

AMD Phenom II N660 3.00-GHz processor (2.0MB L2 cache, 1333-MHz, 3.6GT/sec, dual core, 35 W)

√

AMD Phenom II P960 1.80-GHz processor (2.0MB L2 cache, 1066-MHz, 3.6GT/sec, quad core, 25 W)

√

AMD Phenom II P860 2.00-GHz processor (1.5MB L2 cache, 1333-MHz, 3.6GT/sec, triple core, 25 W)

√

AMD Phenom II P650 2.60-GHz processor (2.0MB L2 cache, 1066-MHz, 3.6GT/sec, triple core, 25 W)

√

AMD Turion II P560 2.50-GHz processor (2.0MB L2 cache, 1066-MHz, 3.6GT/sec, dual core, 25 W)

√

AMD V160 2.40-GHz processor (512-KB L2 cache,
1066-MHz 3.2-GT/sec, single core, 25 W)

√

AMD V140 2.30-GHz processor (512-KB L2 cache,
1066-MHz 3.2-GT/sec, single core, 25 W)

√

Computer models
equipped with an
Intel processor

Intel® Core i7-2640M 2.80-GHz (SC turbo up to 3.50GHz) processor (4.0-MB L3 cache, dual core, 35 W)

√

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40GHz) processor (4.0-MB L3 cache, dual core, 35 W)

√

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90GHz) processor (3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00GHz) processor (3.0-MB L3 cache, dual core, 35 W)

√

i5-2450M 2.50-GHz (SC turbo up to 3.10-GHz)
processor (3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20GHz) processor (3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30GHz) processor (3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i5-480M 2.66-GHz (SC turbo up to 2.93-GHz)
processor (3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i3-2370M 2.40-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Core i3-2350M 2.30-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Core i3-2330M 2.20-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Core i3-2310M 2.10-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Core i3-390M 2.66-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Core i3-380M 2.53-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Chapter 1 Product description

Category

Chipset

Description

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Intel Pentium B970 2.30-GHz processor (2.0MB L3 cache, dual core, 35 W)

√

Intel Pentium B960 TJ85 2.20-GHz processor (2.0MB L3 cache, dual core, 35 W)

√

Intel Pentium B950 TJ85 2.10-GHz processor (2.0MB L3 cache, dual core, 35 W)

√

Intel Pentium B940 TJ85 2.00-GHz processor (2.0MB L3 cache, dual core, 35 W)

√

Intel Pentium P6200 2.13-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Pentium P6300 2.26-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Northbridge: AMD A60M Fusion controller hub

√

Northbridge: AMD RS880M and AMD RS880MD
Southbridge: SB820M
Intel® HM65 and Intel HM55 Express chipset
Graphics

Internal graphics:
●

AMD Radeon™ HD 6620M graphics used in
A8-3520M processor (APU)

●

AMD Radeon HD 6520M graphics used in
A6-3420M processor (APU)

●

AMD Radeon HD 6480M graphics used in
A4-3305M and 3320M processors (APUs)

●

AMD Radeon HD 6380M graphics used in
E2-3000M processor (APU)

●

AMD Radeon HD 6310 discrete class graphics
supporting DX11

●

AMD Mobility Radeon HD 4250 graphics
supporting DX10.1

√
√
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Category

Description

Switchable discrete graphics:
●

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

√

AMD Radeon HD7450M with 1024-MB of
dedicated video memory (128 MB×16 DDR3 @
900 MHz × 4 modules); support for Blu-ray and/or
HD-DVD playback with HD decode
AMD Radeon HD6470M with 1024-MB of
dedicated video memory (128 MB×16 DDR3 @
900 MHz × 4 modules); support for Blu-ray and/or
HD-DVD playback with HD decode

●

AMD Radeon HD6470M with 512-MB of dedicated
video memory (64 MB×16 DDR3 @ 900 MHz × 4
modules); support for Blu-ray and/or HD-DVD
playback with HD decode

●

DX11 support on computer models equipped with
an AMD A8, A6, or A4 processor

●

DX10 support on computer models equipped with
an AMD Athlon, Phenom, or Turion processor and
a graphics subsystem with UMA memory

Internal graphics:
●

Intel HD Graphics 3000 on computer models
equipped with an Intel Core i7, i5, or i3 processor

●

Intel HD Graphics on computer models equipped
with an Intel Pentium processor

Switchable discrete graphics:
●

nVidia N12P-GV (NVIDIA® GeForce® GT 610M)
with 1024-MB of dedicated video memory (128
MB×16 DDR3 @ 900 MHz × 4 modules); 64-bit
23×23mm muxless switchable, supports HD
Decode, DX11, and HDMI

●

nVidia N12P-GV (NVIDIA GeForce GT 520M) with
1024-MB of dedicated video memory (128 MB×16
DDR3 @ 900 MHz × 4 modules); 64-bit 23×23mm
muxless switchable, supports HD Decode, DX11,
and HDMI

●

Radeon HD 7450M with 1024-MB of dedicated
video memory (128-MB×16 DDR3 @ 900 MHz × 4
modules); 64-bit S3 package muxless switchable,
supports HD Decode, DX11, and HDMI
Radeon HD 6470M with 1024-MB of dedicated
video memory (128-MB×16 DDR3 @ 900 MHz × 4
modules); 64-bit S3 package muxless switchable,
supports HD Decode, DX11, and HDMI

●

4

Radeon HD 6470M with 512-MB of dedicated
video memory (64-MB×16 DDR3 @ 900 MHz × 4
modules); 64-bit S3 package muxless switchable,
supports HD Decode, DX11, and HDMI
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√

√

Category

Description

Panel

14.0-in, high-definition (HD), light-emitting diode (LED),
SVA BrightView (1366×768) display;
typical brightness: 200 nits

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

√

√

2 customer-accessible/upgradable memory module
slots

√

√

Supports dual-channel memory

√

√

Supports up to 8192 GB of system RAM

√

√

DDR3/1333-MHz

√

√

Supports the following configurations:

√

√

Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37in) and 7.0-mm (.28-in) thicknesses

√

√

Customer-accessible

√

√

Serial ATA

√

√

Supports the following single hard drive configurations:

√

√

Fixed

√

√

Serial ATA

√

√

12.7-mm tray load

√

√

All display assemblies include 2 wireless local area
network (WLAN) antenna cables
Supports 16:9 wide aspect ratio
Lighted logo on top bezel
Memory

Hard drives

Optical drive

●

8192-MB total system memory (4096×2; not
supported with Windows® 7 32-bit
operating system)

●

6144-MB total system memory (4096×1 + 2048×1)

●

4096-MB total system memory (4096×1 or
2048×2)

●

3072-MB total system memory (2048×1 + 1024×1)

●

2048-MB total system memory (2048×1 or
1024×2)

●

1024-MB total system memory (1024×1; not
supported with Windows 7 64- or 32-bit
operating system)

●

750 GB, 5400 rpm, 9.5 mm

●

640 GB, 5400 rpm, 9.5 mm

●

500 GB, 7200 rpm, 9.5 mm

●

500 GB, 5400 rpm, 9.5 mm

●

320 GB, 7200 rpm, 7.0 mm

5

Category

Description

Computer models
equipped with an
AMD processor

Supports Blu-ray ROM DVD±R/RW Super Multi DoubleLayer Drive

√

√

Supports DVD±RW and CD-RW Super Multi DoubleLayer Combo Drive

√

√

Supports zero-power optical drive
Audio and video

√

One digital microphone

√

√

HD audio

√

√

Supports SRS Premium Sound

√

√

2 Pavilion-branded Altec Lansing speakers

√

√

Low-light HD VGA webcam (fixed, no tilt) with
activity LED, 640×480 by 24 frames per second

√

√

Ethernet

Integrated 10/100 network interface card (NIC)

√

√

Wireless

Integrated wireless local area network (WLAN) options
by way of wireless module

√

√

Two WLAN antennas built into display assembly

√

√

Support for the following WLAN formats:

√

√

√

√

External media
card

6

Computer models
equipped with an
Intel processor

●

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

●

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter

●

Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070
Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

●

Intel Centrino Wireless-N 1000

●

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter

●

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and
Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

HP Multi-Format Digital Media Reader supports
the following digital card formats:
●

MultiMediaCard

●

Secure Digital (SD) Memory Card

●

Secure Digital High Capacity Memory card

●

Secure Digital Extended Capacity Memory Card
with support of UHS104

Chapter 1 Product description

Category

Description

Ports

●

3-pin AC power

●

Audio-in (mono microphone)

●

Audio-out (stereo headphone)

●

HDMI version 1.4 supporting up to 1080p,
1920×1200 @ 60Hz and 1920×1200 @ 60Hz in
DVI mode

●

RJ-45 (Ethernet, includes link and activity lights)

●

USB 2.0 (3 ports)

●

VGA (Dsub 15 pin) supporting:

Keyboard/pointing
devices

Power
requirements

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

√

√

Full-size, textured, pocket keyboard

√

√

TouchPad with gesture support

√

√

Taps enabled by default

√

√

90W slim travel AC adapter with localized cable plug
support (3-wire plug with ground pin, supports 3-pin
DC connector)

√

√

√

√

√

√

◦

2048×1536 external resolution @ 85Hz (on
computer models equipped with an AMD
Athlon, Phenom, Turion, or V-series
processor)

◦

2560×1600 external resolution @ 60Hz (on
computer models equipped with an AMD
E450 or E350 processor)

◦

1920×1600 external resolution @ 60Hz (on
computer models equipped with an AMD A8,
A6, A4, or E2 processor)

◦

Hot plug and unplug and auto-detection for
correct output to wide-aspect vs. standard
aspect video

65W slim travel AC adapter with localized cable plug
support (3-wire plug with ground pin, supports 3-pin
DC connector)
Support for the following batteries:
●

9-cell, 3.00-Ah (100-Wh) Li-ion battery

●

6-cell, 2.80-Ah (62-Wh) Li-ion battery

●

6-cell, 2.55-Ah (55-Wh) Li-ion battery

●

6-cell, 2.20-Ah (47-Wh) Li-ion battery

Supports fast charge on 6-cell batteries
Security

Security cable slot

7

Category

Description

Computer models
equipped with an
AMD processor

Operating system

Preinstalled:

√

Serviceability

8

●

Windows 7 Home Basic 64-bit

●

Windows 7 Home Premium 64-bit

●

Windows 7 Starter (32-bit; only with 500 GB and
smaller hard drives, 2 GB and less of system
memory, Intel Pentium P6200 processor, AMD Vseries or Athlon II processor, cannot support
switchable graphics)

●

FreeDOS

●

Windows 7 Home Basic 64-bit

●

Windows 7 Home Premium 64-bit

●

Windows 7 Home Professional 64-bit

●

Windows 7 Professional 64- and 32-bit

●

Windows 7 Starter (32-bit; only with 500 GB and
smaller hard drives, 2 GB and less of system
memory, Intel Pentium P6200 processor, AMD Vseries or Athlon II processor, cannot support
switchable graphics)

●

FreeDOS

End-user replaceable parts:
●

AC adapter

●

Battery

●

Hard drive

●

Memory modules (2)

●

Optical drive

●

WLAN module

Chapter 1 Product description

Computer models
equipped with an
Intel processor

√

√

√

2

External component identification

Display

Item

Component

Description

(1)

WLAN antennas (2)*

Send and receive wireless signals to communicate
with WLAN devices.

(2)

Webcam light

On: The webcam is in use.

(3)

Webcam

Records video and captures still photographs. To use
the webcam, select Start > All Programs >
CyberLink YouCam > CyberLink YouCam.

(4)

Internal microphone

Records sound.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display

9

Top
Button

Component

Description

Power button*

●

When the computer is off, press the button to
turn on the computer.

●

When the computer is on, press the button
briefly to initiate Sleep.

●

When the computer is in the Sleep state, press
the button briefly to exit Sleep.

●

When the computer is in Hibernation, press
the button briefly to exit Hibernation.

If the computer has stopped responding and
Windows® shutdown procedures are ineffective,
press and hold the power button for at least 5
seconds to turn off the computer.
To learn more about your power settings, select Start
> Control Panel > System and Security > Power
Options, or refer to the HP Notebook Reference
Guide.
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Chapter 2 External component identification

Keys

Item

Component

Description

(1)

esc key

Displays system information when pressed in
combination with the fn key.

(2)

fn key

Displays system information when pressed in
combination with the esc key.

(3)

Windows logo key

Displays the Windows Start menu.

(4)

Windows applications key

Displays a shortcut menu for items beneath
the pointer.

(5)

Action keys

Execute frequently used system functions.

Top
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Lights

Item

Component

Description

(1)

TouchPad light

●

Off: The TouchPad is on.

●

Amber: The TouchPad is off.

●

White: Caps lock is on.

●

Off: Caps lock is off.

●

White: The computer is on.

●

Blinking white: The computer is in the Sleep
state.

●

Off: The computer is off or in Hibernation.

●

White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

●

Amber: All wireless devices are off.

(2)

(3)

(4)

12

Caps lock light

Power light

Wireless light

Chapter 2 External component identification

TouchPad

Item

Component

Description

(1)

TouchPad light

●

Off: The TouchPad is on.

●

Amber: The TouchPad is off.

(2)

TouchPad on/off button

Turns the TouchPad on and off. Quickly double-tap
the TouchPad on/off button to turn the TouchPad on
and off.

(3)

Left TouchPad button

Functions like the left button on an external mouse.

(4)

TouchPad zone

Moves the pointer and selects or activates items on
the screen.

(5)

Right TouchPad button

Functions like the right button on an external mouse.

Top
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Left side

Item

Component

Description

(1)

External monitor port

Connects an external VGA monitor or projector.

(2)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off during
routine operation.

(3)

RJ-45 (network) jack

Connects a network cable.

(4)

HDMI port

Connects an optional video or audio device, such as
a high-definition television, or any compatible digital
or audio component.

(5)

USB ports (2)

Connect optional USB devices.

(6)

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7)

Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset,
or television audio.
WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety
information, refer to the Regulatory, Safety, and
Environmental Notices.
NOTE: When a device is connected to the jack,
the computer speakers are disabled.

(8)

(9)

(10)

14

Drive light

Power light

Digital Media Slot

Chapter 2 External component identification

●

Blinking white: The hard drive is being accessed.

●

Off: The hard drive is idle.

●

White: The computer is on.

●

Blinking white: The computer is in the Sleep
state.

●

Off: The computer is off or in Hibernation.

Supports the following digital card formats:
●

MultiMediaCard

●

Secure Digital (SD) Card

Front

Component

Description

Speakers (2)

Produce sound.

Front
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Right side
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Item

Component

Description

(1)

Optical drive

Reads and writes to an optical disc.

(2)

Optical drive light

●

Green: The optical drive is being accessed.

●

Off: The optical drive is off.

(3)

USB port

Connects an optional USB device.

(4)

AC adapter light

●

White: The computer is connected to external
power and the battery is fully charged.

●

Amber: A battery is charging.

●

Off: The computer is not connected to
external power.

(5)

Power connector

Connects an AC adapter.

(6)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from
being mishandled or stolen.

Chapter 2 External component identification

Bottom components

Item

Component

Description

(1)

Battery bay

Holds the battery.

(2)

Battery release latch

Releases the battery from the battery bay.

(3)

Vents (5)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off during
routine operation.

(4)

Hard drive bay

Holds the hard drive and WLAN device, and contains
the memory module slots.
CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless
module authorized for use in the computer by
the governmental agency that regulates wireless
devices in your country or region. If you replace
the module and then receive a warning message,
remove the module to restore computer functionality,
and then contact technical support through Help and
Support.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Bottom components
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Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

Item

Description

Function

(1)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(2)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part
number helps a service technician to determine
what components and parts are needed.

(3)

Model description

This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

Service tag
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Chapter 3 Illustrated parts catalog

Item

Component

(1)

14.0-in, high definition (HD), light-emitting diode (LED), BrightView display assembly (includes webcam,
two microphones, and wireless antenna transceivers and cables)
In butter gold finish

641343-001

In charcoal gray finish

641338-001

In luminous rose finish

641337-001

In ocean drive finish

639447-001

In Pacific blue finish

641340-001

In pearl pink finish

641341-001

In pewter finish

641339-001

In Sonoma red finish

641336-001

In sweet purple finish

641342-001

In Nero black finish

677167-001

NOTE:
(2)

Spare part number

For more display assembly spare part information, see Display assembly subcomponents on page 29.

Keyboard (includes keyboard cable):
Keyboard with black finish
For use in Brazil

636376-201

For use in Canada

636376-121

For use in India (for use only with computer models equipped with an Intel processor)

636376-D61

For use in Japan

636376-291

For use in Latin America

636376-161

For use in Saudi Arabia (for use only with computer models equipped with an
Intel processor)

636376-171

For use in South Korea

636376-AD1

For use in Taiwan

636376-AB1

For use in Thailand

636376-281

For use in the United States

636376-001

Keyboard with silver finish
For use in Brazil

645893-201

For use in Canada

645893-121

For use in India (for use only with computer models equipped with an Intel processor)

645893-D61

For use in Japan

645893-291

For use in Latin America

645893-161

For use in Saudi Arabia (for use only with computer models equipped with an
Intel processor)

645893-171

For use in South Korea

645893-AD1

Computer major components
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Item

(3)

Component

Spare part number

For use in Taiwan

645893-AB1

For use in Thailand

645893-281

For use in the United States

645893-001

Top cover (includes TouchPad):
In butter gold finish

641351-001

In charcoal gray finish

641346-001

In luminous rose finish

641345-001

In ocean drive finish

639459-001

In Pacific blue finish

641348-001

In pearl pink finish

641349-001

In pewter finish

641347-001

In Sonoma red finish

641344-001

In sweet purple finish

641350-001

In Nero black finish

677168-001

(4)

Power button board (includes cable)

639451-001

(5)

TouchPad button board (includes cable)

639450-001

(6)

TouchPad LED board (includes cable)

640292-001

Cable Kit, includes:

639442-001

(7a)

TouchPad cable

(7b)

Optical drive cable (includes optical drive connector)

(7c)

Hard drive cable
NOTE:

See Cable Kit on page 28 for more Cable Kit spare part information.

(8)

Speaker Kit (includes left and right speakers and cable)

639458-001

(9)

USB board (includes cable)

639452-001

(10)

Power connector cable

639443-001

(11)

System board (includes replacement thermal material):
For use only with computer models equipped with an AMD processor:
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Equipped with a Fusion E-450 1.65-GHz processor (dual core, 18 W) and a graphics
subsystem with UMA video memory

659871-001

Equipped with a Fusion E-350 1.60-GHz processor (dual core, 18 W) and a graphics
subsystem with UMA video memory

645529-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with 1024-MB of discrete video memory

649950-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with 512-MB of discrete video memory

649949-001
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Item

Component

Spare part number

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with UMA video memory

649948-001

For use only with computer models equipped with the AMD RS880MD chipset and a
graphics subsystem with 1024-MB of discrete video memory and supports bus alive/chip
off (BACO)

647627-001

For use only with computer models equipped with the AMD RS880MD chipset and a
graphics subsystem with 512-MB of discrete video memory and supports bus alive/chip
off (BACO)

647626-001

For use only with computer models equipped with a graphics subsystem with 1024-MB
of discrete video memory

638855-001

For use only with computer models equipped with a graphics subsystem with 512-MB of
discrete video memory

638854-001

For use only with computer models equipped with a graphics subsystem with
UMA video memory

638856-001

For use only with computer models equipped with an Intel processor:
For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory and supports NVIDIA GeForce GT
610M

681045-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory and supports NVIDIA GeForce GT
520M

676209-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory and supports bus alive/chip off
(BACO)

650199-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 512-MB of discrete video memory and supports bus alive/chip off
(BACO)

650198-001

For use only with computer models equipped with the Intel HM55 chipset and a graphics
subsystem with 512-MB of discrete video memory

654117-001

For use only with computer models equipped with the Intel HM55 chipset and a graphics
subsystem with UMA video memory

654118-001

For use only with computer models equipped with an HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory

636375-001

For use only with computer models equipped with an HM65 chipset and a graphics
subsystem with 512-MB of discrete video memory

636374-001

For use only with computer models equipped with an HM55 chipset and a graphics
subsystem with 1024-MB of discrete video memory

636372-001

For use only with computer models equipped with an HM55 chipset and a graphics
subsystem with 512-MB of discrete video memory

636371-001

For use only with computer models equipped with an HM65 chipset and a graphics
subsystem with UMA video memory

636373-001

For use only with computer models equipped with an HM55 chipset and a graphics
subsystem with UMA video memory

636370-001

(12)

RTC battery (includes cable and double-sided tape)

637193-001

(13)

Processor (includes replacement thermal material)

Computer major components
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Item

24

Component

Spare part number

AMD A8-3520M 2.50-GHz processor (1.6-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

669690-001

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

653350-001

AMD A6-3420M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

669688-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

653349-001

AMD A4-3320M 2.60-GHz processor (2.0-GHz FSB, 4.0-MB L2 cache, dual core, 35 W)

669690-001

AMD A4-3305M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 45 W)

672093-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W)

653348-001

AMD E2-3000M 2.40-GHz processor (1.8-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

653351-001 or
677628-001

AMD Athlon II P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/
sec, dual core, 25 W)

636635-001

AMD Athlon II P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/
sec, dual core, 25 W)

616343-001

AMD Phenom II N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, quad core, 35 W)

635496-001

AMD Phenom II N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

635495-001

AMD Phenom II N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

616345-001

AMD Phenom II N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, dual core, 35 W)

635494-001

AMD Phenom II P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/
sec, quad core, 25 W)

634689-001

AMD Phenom II P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

634688-001

AMD Phenom II P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25 W)

634687-001

AMD Turion II P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/
sec, dual core, 25 W)

634691-001

AMD V160 2.40-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec,
single core, 25 W)

636634-001

AMD V140 2.30-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec,
single core, 25 W)

616333-001

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (4-MB
L3 cache, dual core, 35 W)

666173-001

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4-MB
L3 cache, dual core, 35 W)

631252-001

Intel Core i5-480M 2.66-GHz (SC turbo up to 2.93-GHz) processor (3-MB
L3 cache, dual core, 35 W)

634693-001
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Item

Component

Spare part number

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3-MB
L3 cache, dual core, 35 W)

631255-001

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3-MB
L3 cache, dual core, 35 W)

631253-001

Intel Core i5-2450M 2.50-GHz (SC turbo up to 3.10-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

676359-001

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

653341-001

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3-MB
L3 cache, dual core, 35 W)

638039-001

Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W)

677152-001

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653340-001

Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653339-001

Intel Core i3-390M 2.66-GHz processor (3-MB L3 cache, dual core, 35 W)

634692-001

Intel Core i3-380M 2.53-GHz processor (3-MB L3 cache, dual core, 35 W)

625823-001

Intel Core i3-2310M 2.10-GHz processor (3-MB L3 cache, dual core, 35 W)

638037-001

Intel Pentium B970 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

676785–001

Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W)

664662-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W)

653338-001

Intel Pentium B940 TJ85 2.00-GHz processor (2.0-MB L3 cache, dual core, 35 W)

653337-001

Intel Pentium P6300 2.26-GHz processor (3-MB L3 cache, dual core, 35 W)

635500-001

Intel Pentium P6200 2.13-GHz processor (3-MB L3 cache, dual core, 35 W)

625831-001

(14)

Fan (includes replacement thermal material)

639460-001

(15)

Heat sink (includes replacement thermal material)
For use only with computer models equipped with an AMD processor:
For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with discrete video memory

649953-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with UMA video memory

649954-001

For use only with computer models equipped with the AMD RS880MD chipset and a
graphics subsystem with discrete video memory

649952-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with discrete video memory

639462-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with UMA video memory

639463-001

For use only with computer models equipped with an Intel processor:
For use only with computer models equipped with the Intel HM65 or HM55 chipset and a
graphics subsystem with discrete video memory

654119-001

Computer major components
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Item

Component

Spare part number

For use only with computer models equipped with the Intel HM65 or HM55 chipset and a
graphics subsystem with UMA video memory

654120-001

For use only with computer models equipped with an HM65 chipset and a graphics
subsystem with discrete video memory

641141-001

For use only with computer models equipped with an HM65 chipset and a graphics
subsystem with UMA video memory

641140-001

For use only with computer models equipped with an HM55 chipset and a graphics
subsystem with discrete video memory

637190-001

For use only with computer models equipped with an HM55 chipset and a graphics
subsystem with UMA video memory

637189-001

(16)

LED board (includes cable)

640293-001

(17)

Base enclosure (includes battery release latch, replacement thermal material,
and 4 rubber feet)

639439-001

Rubber Feet Kit (not illustrated, includes 4 rubber feet)

639455-001

(18)

(19)

(20)

(21)

(22)

Battery:
6-cell, 55-Whr, 2.55-Ah Li-ion battery

593554-001

6-cell, 47-Whr, 2.20-Ah Li-ion battery

593553-001

Optical drive (includes bezel and bracket):
Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive

639449-001 and
659848-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

639448-001 and
659847-001

Optical drive bay space saver (not illustrated)

659618-001

Hard drive (2.5-in, SATA, does not include hard drive cable, isolators, or shield):
750-GB, 5400-rpm

644351-001

640-GB, 5400-rpm

637312-001

500-GB, 7200-rpm

644685-001

320-GB, 7200-rpm

645089-001

Hard Drive Hardware Kit (not illustrated, includes isolators and shield)

639444-001

Memory modules (2, DDR3, 10600, 1333-MHz)
4 GB

621569-001

2 GB

621565-001

1 GB

639736-001

WLAN module:
For use with all computer models:

26

Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

655795-001

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

605560-005
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Item

Component

Spare part number

Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

600370-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

657325-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter

630703-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter

640926-001

For use only with computer models equipped with an AMD processor:
Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo
Adapter (BT3.0+HS ready)

593127-001

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter

593836-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

630705-001

Realtek 8188BC8 802.11a/b/g/n 2×2 WiFi and Bluetooth 3.0+HS Combo Adapter

602993-001

For use only with computer models equipped with an Intel processor:

(23)

Intel Centrino Advanced-N 6230 WLAN module

631956-001

Intel Centrino Wireless-N 1000

593530-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

656120-001

Service cover (includes 2 captive screws, secured by C-clips) — available in the Plastics Kit, spare part number
639453-001)

Computer major components
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Cable Kit

Item

28

Component

Spare part number

Cable Kit, includes:

639442-001

(1)

TouchPad cable

(2)

Optical drive cable

(3)

Hard drive cable
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Display assembly subcomponents

Item

Component

Spare part number

(1)

Display hinge covers (2)

639446-001

(2)

Display bezel

639440-001

(3)

Webcam/microphone module

637197-001

(4)

14.0-in, HD, LED, BrightView display panel

639454-001

(5)

Display Hinge Kit (includes left and right display hinges and brackets)

639445-001

(6)

Display Cable Kit (includes display panel cable and webcam/microphone
module cable)

639441-001

(7)

Antenna Kit (includes left and right wireless antenna cables and transceivers)

640294-001

(8)

Display enclosure:
In butter gold finish

641335-001

In charcoal gray finish

641330-001

In luminous rose finish

641329-001

In ocean drive finish

639438-001

Display assembly subcomponents
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Item

Component

Spare part number

In Pacific blue finish

641332-001

In pearl pink finish

641333-001

In pewter finish

641331-001

In Sonoma red finish

641328-001

In sweet purple finish

641334-001

In Nero black finish

677166-001

Display Screw Kit (not illustrated)

639457-001

Mass storage devices
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Item

Component

(1)

Hard drive (2.5-in, SATA, does not include hard drive cable, isolators, or shield):

Spare part number

750-GB, 5400-rpm

644351-001

640-GB, 5400-rpm

637312-001

500-GB, 7200-rpm

644685-001
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Item

Component

Spare part number

320-GB, 7200-rpm

645089-001

Hard Drive Hardware Kit, includes:

639444-001

(2)

Hard drive isolators (2)

(3)

Hard drive shield

(4)

Optical drive (includes bezel and bracket):
Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive

639449-001 and
659848-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

639448-001 and
659847-001

Optical drive bay space saver (not illustrated)

659618-001

Mass storage devices
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Miscellaneous parts
Component

Spare part number

HP Smart AC adapter
90-W PFC RC V HP Smart AC adapter for use with all computer models

609940-001

65-W RC V HP Smart AC adapter for use only with computer models equipped
with an AMD processor

609939-001

90-W PFC RC V EM HP Smart AC adapter for use only with computer models equipped
with an Intel processor

609947-001

65-W RC V EM HP Smart AC adapter for use only with computer models equipped
with an Intel processor

609948-001

Power cord (3-pin, black, 1.83-m):
For use with all computer models:
For use in Argentina

490371-D01

For use in Brazil

490371-202

For use in Italy

490371-061

For use in North America

490371-001

For use only with computer models equipped with an Intel processor:
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For use in Australia

490371-011

For use in Europe

490371-021

For use in India

490371-D61

For use in Japan

490371-291

For use in the People's Republic of China

490371-AA1

For use in South Korea

490371-AD1

For use in Taiwan

490371-AB1

For use in Thailand

490371-201

For use in the United Kingdom and Singapore

490371-091

Screw Kit

639456-001

Chapter 3 Illustrated parts catalog

Sequential part number listing
Spare part number

Description

490371-001

Power cord for use with all computer models in North America (black, 3-in, 1.83-m)

490371-011

Power cord for use only with computer models equipped with an Intel processor in Australia
(black, 3-in, 1.83-m)

490371-021

Power cord for use only with computer models equipped with an Intel processor in Europe
(black, 3-in, 1.83-m)

490371-031

Power cord for use only with computer models equipped with an Intel processor in
the United Kingdom and Singapore (black, 3-in, 1.83-m)

490371-061

Power cord for use with all computer models in Italy (black, 3-in, 1.83-m)

490371-201

Power cord for use with all computer models in Thailand (black, 3-in, 1.83-m)

490371-202

Power cord for use with all computer models in Brazil (black, 3-in, 1.83-m)

490371-291

Power cord for use only with computer models equipped with an Intel processor in Japan
(black, 3-in, 1.83-m)

490371-AA1

Power cord for use only with computer models equipped with an Intel processor in
the People's Republic of China (black, 3-in, 1.83-m)

490371-AB1

Power cord for use only with computer models equipped with an Intel processor in Taiwan
(black, 3-in, 1.83-m)

490371-AD1

Power cord for use only with computer models equipped with an Intel processor in South Korea
(black, 3-in, 1.83-m)

490371-D01

Power cord for use with all computer models in Argentina (black, 3-in, 1.83-m)

490371-D61

Power cord for use only with computer models equipped with an Intel processor in India
(black, 3-in, 1.83-m)

537921-001

Bluetooth module (for use only with computer models equipped with an Intel processor)
NOTE: The Bluetooth module spare part kit does not include the Bluetooth module cable. The
Bluetooth module cable is available using spare part number 602538-001.

593127-001

Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready) for use only with computer models equipped with an AMD processor

593530-001

Intel Centrino Wireless-N 1000 for use only on computer models equipped
with an Intel processor

593553-001

6-cell, 47-Whr, 2.20-Ah Li-ion battery

593554-001

6-cell, 55-Whr, 2.55-Ah Li-ion battery

593836-001

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter for use only on computer models equipped
with an AMD processor

600370-001

Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready) for use with all computer models

602538-001

Bluetooth module cable (for use only with computer models equipped with an Intel processor)

602993-001

Realtek 8188BC8 802.11a/b/g/n 2×2 WiFi and Bluetooth 3.0+HS Combo Adapter for use only
with computer models equipped with an AMD processor

605560-005

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter for use with for use only with computer models
computer models

Sequential part number listing
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34

Spare part number

Description

609939-001

65-W RC V HP Smart AC adapter for use only with computer models equipped
with an AMD processor

609940-001

90-W PFC RC V HP Smart AC adapter for use with all computer models

609947-001

90-W PFC RC V EM HP Smart AC adapter for use only with computer models equipped
with an Intel processor

609948-001

65-W RC V EM HP Smart AC adapter for use only with computer models equipped
with an Intel processor

616333-001

AMD V140 2.30-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W;
includes replacement thermal material)

616343-001

AMD Athlon II P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/
sec, dual core, 25W; includes replacement thermal material)

616345-001

AMD Phenom II N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35W; includes replacement thermal material)

621565-001

2-GB memory module (DDR3, 10600, 1333-MHz)

621569-001

4-GB memory module (DDR3, 10600, 1333-MHz)

625823-001

Intel Core i3-380M 2.53-GHz processor (3-MB L3 cache, dual core, 35W;
includes replacement thermal material)

625831-001

Intel Pentium P6200 2.13-GHz processor (3-MB L3 cache, dual core, 35W;
includes replacement thermal material)

630703-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter for use with all computer models

630705-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready) for use only with computer models equipped with an AMD processor

631252-001

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4-MB
L3 cache, dual core, 35W; includes replacement thermal material)

631253-001

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3-MB
L3 cache, dual core, 35W; includes replacement thermal material)

631255-001

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3-MB
L3 cache, dual core, 35W; includes replacement thermal material)

631956-001

Intel Centrino Advanced-N 6230 WLAN module for use only on computer models equipped with
an Intel processor

634687-001

AMD Phenom II P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25W; includes replacement thermal material)

634688-001

AMD Phenom II P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35W; includes replacement thermal material)

634689-001

AMD Phenom II P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/
sec, quad core, 25W; includes replacement thermal material)

634691-001

AMD Turion II P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/
sec, dual core, 25W; includes replacement thermal material)

634692-001

Intel Core i3-390M 2.66-GHz processor (3-MB L3 cache, dual core, 35W;
includes replacement thermal material)

634693-001

Intel Core i5-480M 2.66-GHz (SC turbo up to 2.93-GHz) processor (3-MB
L3 cache, dual core, 35W; includes replacement thermal material)
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635494-001

AMD Phenom II N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, dual core, 35W; includes replacement thermal material)

635495-001

AMD Phenom II N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35W; includes replacement thermal material)

635496-001

AMD Phenom II N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, quad core, 35W; includes replacement thermal material)

635500-001

Intel Pentium P6300 2.26-GHz processor (3-MB L3 cache, dual core, 35W;
includes replacement thermal material)

636370-001

System board for use only with computer models equipped with an Intel processor, HM55
chipset, and a graphics subsystem with UMA video memory
(includes replacement thermal material)

636371-001

System board for use only with computer models equipped with an Intel processor, HM55
chipset, and a graphics subsystem with 512-MB of discrete video memory
(includes replacement thermal material)

636372-001

System board for use only with computer models equipped with an Intel processor, HM55
chipset, and a graphics subsystem with 1024-MB of discrete video memory
(includes replacement thermal material)

636373-001

System board for use only with computer models equipped with an Intel processor, HM65
chipset, and a graphics subsystem with UMA video memory
(includes replacement thermal material)

636374-001

System board for use only with computer models equipped with an Intel processor, HM65
chipset, and a graphics subsystem with 512-MB of discrete video memory
(includes replacement thermal material)

636375-001

System board for use only with computer models equipped with an Intel processor, HM65
chipset, and a graphics subsystem with 512-MB of discrete video memory
(includes replacement thermal material)

636376-001

Keyboard with black finish for use in the United States (includes cable)

636376-121

Keyboard with black finish for use in Canada (includes cable)

636376-161

Keyboard with black finish for use in Latin America (includes cable)

636376-171

Keyboard with black finish for use in Saudi Arabia only with computer models equipped with an
Intel processor (includes cable)

636376-201

Keyboard with black finish for use in Brazil (includes cable)

636376-281

Keyboard with black finish for use in Thailand (includes cable)

636376-291

Keyboard with black finish for use in Japan (includes cable)

636376-AB1

Keyboard with black finish for use in Taiwan (includes cable)

636376-AD1

Keyboard with black finish for use in South Korea (includes cable)

636376-D61

Keyboard with black finish for use in India only with computer models equipped with an
Intel processor (includes cable)

636634-001

AMD V160 2.40-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25W;
includes replacement thermal material)

636635-001

AMD Athlon II P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/
sec, dual core, 25W; includes replacement thermal material)
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637189-001

System board for use only with computer models equipped with an Intel processor, HM55
chipset, and a graphics subsystem with UMA video memory
(includes replacement thermal material)

637190-001

System board for use only with computer models equipped with an Intel processor, HM55
chipset, and a graphics subsystem with discrete video memory
(includes replacement thermal material)

637193-001

RTC battery (includes cable and double-sided tape)

637197-001

Webcam/microphone module

637312-001

640-GB, 5400-rpm hard drive (2.5-in, SATA, does not include isolators or shield)

638037-001

Intel Core i3-2310M 2.10-GHz processor (3-MB L3 cache, dual core, 35W;
includes replacement thermal material)

638039-001

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3-MB
L3 cache, dual core, 35W; includes replacement thermal material)

638854-001

System board for use only with computer models equipped with an AMD processor and a
graphics subsystem with 512-MB of discrete video memory
(includes replacement thermal material)

638855-001

System board for use only with computer models equipped with an AMD processor and a
graphics subsystem with 1024-MB of discrete video memory
(includes replacement thermal material)

638856-001

System board for use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA video memory (includes replacement thermal material)

639438-001

Display enclosure in ocean drive finish

639439-001

Base enclosure (includes battery release latch, replacement thermal material, and 4 rubber feet)

639440-001

Display bezel

639441-001

Display Cable Kit (includes display panel cable and webcam/microphone module cable)

639442-001

Cable Kit (includes TouchPad cable, optical drive cable, and hard drive cable)
See Cable Kit on page 28 for more Cable Kit spare part information.
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639443-001

Power connector cable

639444-001

Hard Drive Hardware Kit (includes hard drive isolators and shield)

639445-001

Display Hinge Kit (includes left and right display hinges and brackets)

639446-001

Display hinge covers

639447-001

14.0-in, HD, LED, BrightView display assembly in ocean drive finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

639448-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive (includes bezel and bracket)

639449-001

Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive (includes bezel and bracket)

639450-001

TouchPad button board (includes cable)

639451-001

Power button board (includes cable)

639452-001

USB board (includes cable)

639453-001

Plastics Kit

639454-001

14.0-in, HD, LED, BrightView display panel
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639455-001

Rubber Feet Kit (includes 4 rubber feet)

639456-001

Screw Kit

639457-001

Display Screw Kit

639458-001

Speaker Kit (includes left and right speakers and cable)

639459-001

Top cover in ocean drive finish (includes TouchPad)

639460-001

Fan (includes replacement thermal material)

639462-001

Heat sink for use only with computer models equipped with an AMD processor and a graphics
subsystem with discrete video memory (includes replacement thermal material)

639463-001

Heat sink for use only with computer models equipped with an AMD processor and a graphics
subsystem with UMA video memory (includes replacement thermal material)

639736-001

1-GB memory module (DDR3, 10600, 1333-MHz)

640292-001

TouchPad LED board (includes cable)

640293-001

LED board (includes cable)

640294-001

Antenna Kit (includes left and right wireless antenna cables and transceivers)

640926-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter for use with all computer models

641140-001

Heat sink for use only with computer models equipped with an Intel processor, HM65 chipset,
and a graphics subsystem with UMA video memory (includes replacement thermal material)

641141-001

Heat sink for use only with computer models equipped with an Intel processor, HM65 chipset,
and a graphics subsystem with discrete video memory (includes replacement thermal material)

641328-001

Display enclosure in Sonoma red finish

641329-001

Display enclosure in luminous rose finish

641330-001

Display enclosure in charcoal grey finish

641331-001

Display enclosure in pewter finish

641332-001

Display enclosure in Pacific blue finish

641333-001

Display enclosure in pearl pink finish

641334-001

Display enclosure in sweet purple finish

641335-001

Display enclosure in butter gold finish

641336-001

14.0-in, HD, LED, BrightView display assembly in Sonoma red finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641337-001

14.0-in, HD, LED, BrightView display assembly in luminous rose finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641338-001

14.0-in, HD, LED, BrightView display assembly in charcoal gray finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641339-001

14.0-in, HD, LED, BrightView display assembly in pewter finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641340-001

14.0-in, HD, LED, BrightView display assembly in Pacific blue finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641341-001

14.0-in, HD, LED, BrightView display assembly in pearl pink finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)
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641342-001

14.0-in, HD, LED, BrightView display assembly in sweet purple finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641343-001

14.0-in, HD, LED, BrightView display assembly in butter gold finish (includes webcam,
two microphones, and wireless antenna transceivers and cables)

641344-001

Top cover in Sonoma red finish (includes TouchPad)

641345-001

Top cover in luminous rose finish (includes TouchPad)

641346-001

Top cover in charcoal gray finish (includes TouchPad)

641347-001

Top cover in pewter finish (includes TouchPad)

641348-001

Top cover in Pacific blue finish (includes TouchPad)

641349-001

Top cover in pearl pink finish (includes TouchPad)

641350-001

Top cover in sweet purple finish (includes TouchPad)

641351-001

Top cover in butter gold finish (includes TouchPad)

644351-001

750-GB, 5400-rpm hard drive (2.5-in, SATA, does not include isolators or shield)

644685-001

500-GB, 7200-rpm hard drive (2.5-in, SATA, does not include isolators or shield)

645089-001

320-GB, 7200-rpm hard drive (2.5-in, SATA, does not include isolators or shield)

645529-001

System board for use only with computer models equipped with an AMD Fusion E-350 1.60GHz processor (dual core, 18 W) and a graphics subsystem with UMA video memory (includes
replacement thermal material)

645893-001

Keyboard with silver finish for use in the United States (includes keyboard cable)

645893-121

Keyboard with silver finish for use in Canada (includes keyboard cable)

645893-161

Keyboard with silver finish for use in Latin America (includes keyboard cable)

645893-171

Keyboard with black finish for use in Saudi Arabia only with computer models equipped with an
Intel processor (includes cable)

645893-201

Keyboard with silver finish for use in Brazil (includes keyboard cable)

645893-281

Keyboard with silver finish for use in Thailand (includes keyboard cable)

645893-291

Keyboard with silver finish for use in Japan (includes keyboard cable)

645893-AB1

Keyboard with silver finish for use in Taiwan (includes keyboard cable)

645893-AD1

Keyboard with silver finish for use in South Korea (includes keyboard cable)

645893-D61

Keyboard with silver finish for use in India for use only with computer models equipped with an
Intel processor (includes keyboard cable)

647626-001

System board for use only with computer models equipped with the AMD RS880MD chipset, an
AMD processor, and a graphics subsystem with 512-MB of discrete video memory, and
supports bus alive/chip off (BACO; includes replacement thermal material)

647627-001

System board for use only with computer models equipped with the AMD RS880MD chipset, an
AMD processor, and a graphics subsystem with 1024-MB of discrete video memory, and
upports bus alive/chip off (BACO; includes replacement thermal material)

649948-001

System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)
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649949-001

System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with 512-MB of discrete video memory (includes
replacement thermal material)

649950-001

System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with 1024-MB of discrete video memory (includes
replacement thermal material)

649952-001

Heat sink for use only with computer models equipped with the AMD RS880MD chipset, an
AMD processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

649953-001

Heat sink for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

649954-001

Heat sink for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

650198-001

System board for use only with computer models equipped with the Intel HM65 chipset, an
Intel processor, and a graphics subsystem with 512-MB of discrete video memory (includes
replacement thermal material)

650199-001

System board for use only with computer models equipped with the Intel HM65 chipset, an
Intel processor, and a graphics subsystem with 1024-MB of discrete video memory (includes
replacement thermal material)

653337-001

Intel Pentium B940 TJ85 2.00-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653338-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653339-001

Intel Core i3-2330M 2.20-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

653340-001

Intel Core i3-2350M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

653341-001

Intel Core i5-2430M 2.40-GHz processor (turbo up to 3.00-GHz; 1333-MHz, 3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

653348-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

653349-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

653350-001

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

653351-001 or
677628-001

AMD E2-3000M 2.40-GHz processor (1.8-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

654117-001

System board for use only with computer models equipped with the Intel HM55 chipset, an
Intel processor, and a graphics subsystem with 512-MB of discrete video memory (includes
replacement thermal material)

654118-001

System board for use only with computer models equipped with the Intel HM55 chipset, an
Intel processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)
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654119-001

Heat sink for use only with computer models equipped with the Intel HM65 or HM55 chipset, an
Intel processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

654120-001

Heat sink for use only with computer models equipped with the Intel HM65 or HM55 chipset, an
Intel processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

655795-001

Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter for use with all
computer models

656120-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter (BT3.0+HS
ready) for use only with computer models equipped with an Intel processor

657325-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter for use with
all computer models

659618-001

Optical drive bay space saver

659847-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

659848-001

Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive

659871-001

System board for use only with computer models equipped with an AMD Fusion E-450 1.65GHz processor (dual core, 18 W) and a graphics subsystem with UMA video memory (includes
replacement thermal material)

664662-001

Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

666173-001

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (4-MB
L3 cache, dual core, 35 W; includes replacement thermal material)

669686-001

AMD A4-3320M 2.60-GHz processor (2.0-GHz FSB, 4.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

669688-001

AMD A6-3420M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

669690-001

AMD A8-3520M 2.50-GHz processor (1.6-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

672093-001

AMD A4-3305M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 45 W;
includes replacement thermal material)

676209-001

System board for use only with computer models equipped with the Intel HM65 chipset and a
graphics subsystem with 1024-MB of discrete video memory and NVIDIA GeForce GT 520M

676359-001

Intel Core i5-2450M 2.50-GHz processor (turbo up to 3.10-GHz; 1333-MHz, 3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

676785-001

Intel Pentium B970 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

677152-001

Intel Core i3-2370M 2.40-GHz processor (turbo up to 3.00-GHz; 1333-MHz, 3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

677166-001

Display enclosure for use in black models

677167-001

Display assembly for use in black models

677168-001

Top cover for use in black models (includes touchpad)

681045-001

System board for use only with computer models equipped with the Intel HM65 chipset and a
graphics subsystem with 1024-MB of discrete video memory and NVIDIA GeForce GT 610M
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in
the maintenance instructions.

Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Preliminary replacement requirements
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Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through
the operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
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CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
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●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of staticsafe materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
Material

Use

Voltage protection level

Antistatic plastics

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V

Preliminary replacement requirements
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 51 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw and screw lock size and location during removal
and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.
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Item

Description

Function

(1)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(2)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part
number helps a service technician to determine
what components and parts are needed.

(3)

Model description

This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Feet Kit,
spare part number 639455-001. There are 4 rubber feet that attach to the base enclosure in
the locations illustrated below.
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Battery
Description

Spare part number

6-cell, 55-Whr, 2.55-Ah Li-ion battery

593554-001

6-cell, 47-Whr, 2.20-Ah Li-ion battery

593553-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Slide the battery release latch (1) to release the battery.

2.

Pivot the front edge of the battery (2) up and back.

3.

Remove the battery (3) from the computer.

To insert the battery:
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1.

Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery
bay.

2.

Pivot the front edge of the battery down into the battery bay until it is seated. (The battery
release latch will automatically lock into place.)
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Optical drive
NOTE:

The optical drive spare part kit includes a bezel and bracket.

Description

Spare part number

Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive

639449-001 and
659848-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

639448-001 and
659847-001

Optical drive bay space saver

659618-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48).

Remove the optical drive:
1.

Loosen the two captive screws (1) that secure the service cover to the computer.

2.

Lift the rear edge of the service cover (2) up and forward until it rests at an angle.

3.

Remove the service cover. The service cover is available in the Plastics Kit, spare part number
639453-001.
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4.

Remove the Phillips PM2.5×6.0 screw that secures the optical drive to the computer.

5.

Insert a thin tool, such as an unbent paper clip (1), into the optical drive release hole. (The
optical drive tray releases.)

6.

Use the optical drive tray to remove the optical drive (2) from the computer.

7.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

8.

Remove the two Phillips PM2.0×4.0 screws (1) that secure the bracket to the optical drive.
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9.

Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Hard drive
NOTE: The hard drive spare part kit does not include the hard drive cable, hard drive isolators, or
Mylar shield. The hard drive isolators and Mylar shield are included in the Hard Drive Hardware Kit,
spare part number 639444-001. The hard drive cable is included in the Cable Kit, spare part number
639442-001.
Description

Spare part number

750-GB, 5400-rpm

644351-001

640-GB, 5400-rpm

637312-001

500-GB, 7200-rpm

644685-001

320-GB, 7200-rpm

645089-001

Before removing the mass storage device, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48).

5.

Remove the service cover (see Optical drive on page 49).

Remove the hard drive:
1.

Disconnect the hard drive cable (1) from the system board.
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2.

Lift the front edge of the hard drive (2) until it rests at an angle.

3.

Remove the hard drive.

4.

If it is necessary to replace the hard drive cable (1) or the hard drive isolators (2) from the hard
drive, remove and replace the components. The hard drive cable is included in the Cable Kit,
spare part 639442-001. The hard drive isolators are available in the Hard Drive Hardware Kit,
spare part number 639444-001.

Reverse this procedure to reassemble and install the mass storage device.
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Memory module
Description

Spare part number

4-GB (PC3, 10600, 1333-MHz)

621569-001

2-GB (PC3, 10600, 1333-MHz)

621565-001

1-GB (PC3, 10600, 1333-MHz)

639736-001

Before removing a memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48).

5.

Remove the service cover (see Optical drive on page 49).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2.

Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.
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WLAN module
Description

Spare part number

For use on all computer models:
Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

655795-001

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

605560-005

Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

600370-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

657325-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter

630703-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter

640926-001

For use only with computer models equipped with an AMD processor:
Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

593127-001

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter

593836-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

630705-001

Realtek 8188BC8 802.11a/b/g/n 2×2 WiFi and Bluetooth 3.0+HS Combo Adapter

602993-001

For use only with computer models equipped with an Intel processor:
Intel Centrino Advanced-N 6230 WLAN module

631956-001

Intel Centrino Wireless-N 1000

593530-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter (BT3.0+HS
ready)

656120-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48).

5.

Remove the service cover (see Optical drive on page 49).
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Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The 1/black WLAN antenna cable is connected to the WLAN module 1/Main terminal.
The 2/gray WLAN antenna cable is connected to the WLAN module 2/Aux terminal.

2.

Remove the Phillips PM2.0×4.0 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up.)

3.

Remove the WLAN module by pulling the module away from the slot at an angle (3).
NOTE: The WLAN module is designed with a notch (4) to prevent incorrect installation into
the WLAN module socket.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module,
the protective sleeves must be installed on the antenna connectors, as shown in the following
illustration.

Reverse this procedure to install the WLAN module.
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Keyboard
NOTE:

The keyboard spare part kit includes a keyboard cable.

Description

Spare part number

Keyboard with black finish for use in Brazil

636376-201

Keyboard with black finish for use in Canada

636376-121

Keyboard with black finish for use in India (for use only with computer models equipped with an
Intel processor)

636376-D61

Keyboard with black finish for use in Japan

636376-291

Keyboard with black finish for use in Latin America

636376-161

Keyboard with black finish for use in Saudi Arabia (for use only with computer models equipped
with an Intel processor)

636376-171

Keyboard with black finish for use in South Korea

636376-AD1

Keyboard with black finish for use in Taiwan

636376-AB1

Keyboard with black finish for use in Thailand

636376-281

Keyboard with black finish for use in the United States

636376-001

Keyboard with silver finish for use in Brazil

645893-201

Keyboard with silver finish for use in Canada

645893-121

Keyboard with silver finish for use in India (for use only with computer models equipped with an
Intel processor)

645893-D61

Keyboard with silver finish for use in Japan

645893-291

Keyboard with silver finish for use in Latin America

645893-161

Keyboard with silver finish for use in Saudi Arabia (for use only with computer models equipped
with an Intel processor)

645893-171

Keyboard with silver finish for use in South Korea

645893-AD1

Keyboard with silver finish for use in Taiwan

645893-AB1

Keyboard with silver finish for use in Thailand

645893-281

Keyboard with silver finish for use in the United States

645893-001

Before removing the keyboard, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48).

5.

Remove the optical drive (see Optical drive on page 49).
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Remove the keyboard:
1.

Remove the Phillips PM2.5×6.0 screw that secures the keyboard to the computer.

2.

Rest the computer on its left side.

3.

Open the computer.

4.

Insert a screw driver or similar thin tool into the keyboard screw hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5.

Turn the computer right-side up with the front toward you.
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6.

Lift the rear edge of the keyboard (1), and then swing the keyboard (2) up and forward until it
rests upside down on the palm rest.

7.

Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover
NOTE:

The top cover spare part kit includes the TouchPad.

Description

Spare part number

In butter gold finish

641351-001

In charcoal gray finish

641346-001

In luminous rose finish

641345-001

In ocean drive finish

639459-001

In Pacific blue finish

641348-001

In pearl pink finish

641349-001

In pewter finish

641347-001

In Sonoma red finish

641344-001

In sweet purple finish

641350-001

In Nero black finish

677168-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

When replacing the top cover, be sure that the following components are removed from the defective
top cover and installed on the replacement top cover:
●

Power button board and cable (see Power button board on page 63)

●

TouchPad button board and cable (see TouchPad button board on page 64)

●

TouchPad LED board and cable (see TouchPad LED board on page 65)

Remove the top cover:
1.

Close the computer.

2.

Turn the computer upside down, with the front toward you.
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3.

Remove the nine Phillips PM2.5×7.0 screws that secure the top cover to the computer.

4.

Remove the following screws:
(1) Two Phillips PM 2.5×4.0 screws in the hard drive bay
(2) One Philllips PM2.5×6.0 screw near the memory module bay
(3) One Philllips PM2.5×6.0 screw on the right side of the hard drive bay
(4) Three Phillips PM2.5×6.0 screws in the battery bay
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5.

Turn the computer right-side up, with the front toward you.

6.

Open the computer.
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7.

Release the ZIF connectors to which the following cables are attached, and then disconnect
the cables from the system board:
(1) Power button board cable (included with the power button board spare part kit)
(2) TouchPad cable (included in the Cable Kit, spare part number 639442-001)
(3) TouchPad button board cable (included with the TouchPad button board spare part kit)

8.

Lift the front edge of the top cover (1) until the left and right sides disengage from
the base enclosure.
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9.

Remove the top cover (2).

Reverse this procedure to install the top cover.
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Power button board
Description

Spare part number

Power button board (includes cable)

639451-001

Before removing the power button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the power button board:
1.

Turn the top cover upside down, with the front toward you.

2.

Remove the Phillips PM2.0×3.0 screw (1) that secures the power button board to the top cover.

3.

Remove the power button board and cable (2).

Reverse this procedure to install the power button board.
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TouchPad button board
Description

Spare part number

TouchPad button board (includes cable)

639450-001

Before removing the TouchPad button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the TouchPad button board and cable:
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1.

Turn the top cover upside down, with the front toward you.

2.

Release the ZIF connector to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (1) from the TouchPad button board.

3.

Release the tape (2) that secures the TouchPad button board cable to the top cover.

4.

Lift the front edge of the TouchPad button board (3) until it is released from the clips built into
the top cover.
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5.

Remove the TouchPad button board (4) and cable.

Reverse this procedure to install the TouchPad button board and cable.

TouchPad LED board
Description

Spare part number

TouchPad LED board (includes cable)

640292-001

Before removing the TouchPad LED board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the TouchPad LED board and cable:
1.

Turn the top cover upside down, with the front toward you.

2.

Release the ZIF connector (1) to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (2) from the TouchPad button board.
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3.

Detach the TouchPad LED board (2) from the top cover. (The TouchPad LED board is attached
to the top cover with double-sided tape.)

4.

Remove the TouchPad LED board and cable.

Reverse this procedure to install the TouchPad LED board and cable.
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Speakers
Description

Spare part number

Speaker Kit (includes left and right speakers and cable)

639458-001

Before removing the speakers, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the TouchPad LED board and cable:
1.

Disconnect the speaker cable (1) from the system board.

2.

Release the speaker cable from the clips built into the base enclosure (2).

3.

Remove the speakers (3).

Reverse this procedure to install the speakers.
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Optical drive cable
NOTE: The optical drive cable is included in the Cable Kit, spare part number 639442-001. The
optical drive cable includes the optical drive connector.
Before removing the optical drive cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

●

Speakers (see Speakers on page 67)

Remove the optical drive cable:
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1.

Close the computer.

2.

Turn the computer upside down, with the front toward you.

3.

Release the clips (1) that secure the optical drive connector to the base enclosure.

4.

Release the optical drive connector (2) from the base enclosure.

5.

Turn the computer right-side up, with the front toward you.
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6.

Open the computer.

7.

Disconnect the optical drive cable (1) from the system board.

8.

Release the optical drive cable (2) from the clips built into the base enclosure.

9.

Remove the optical drive cable.

Reverse this procedure to install the optical drive cable.
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USB board
Description

Spare part number

USB board (includes cable)

639452-001

Before removing the USB board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the USB board:
1.

Release the ZIF connector (1) to which the USB board cable is connected, and then disconnect
the USB board cable (2) from the system board.

2.

Remove the Phillips PM2.5×6.0 screw (3) that secures the USB board to the base enclosure.

3.

Remove the USB board (4) and cable.

Reverse this procedure to install the USB board.
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Power connector cable
Description

Spare part number

Power connector cable

639443-001

Before removing the power connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the power connector cable:
1.

Disconnect the power connector cable (1) from the system board.

2.

Release the power connector cable (2) from the clip built into the base enclosure.

3.

Remove the power connector (3) from the clip built into the base enclosure.

Reverse this procedure to install the power connector cable.
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System board
NOTE:

The system board spare part kit includes replacement thermal material.

Description

Spare part number

For use only with computer models equipped with an AMD processor:
Equipped with a Fusion E-450 1.65-GHz processor (dual core, 18 W) and a graphics subsystem
with UMA video memory

659871-001

Equipped with a Fusion E-350 1.60-GHz processor (dual core, 18 W) and a graphics subsystem
with UMA video memory

645529-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with 1024-MB of discrete video memory

649950-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with 512-MB of discrete video memory

649949-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with UMA video memory

649948-001

For use only with computer models equipped with the AMD RS880MD chipset and a graphics
subsystem with 1024-MB of discrete video memory and supports bus alive/chip off (BACO)

647627-001

For use only with computer models equipped with the AMD RS880MD chipset and a graphics
subsystem with 512-MB of discrete video memory and supports bus alive/chip off (BACO)

647626-001

For use only with computer models equipped with a graphics subsystem with 1024-MB of
discrete video memory

638855-001

For use only with computer models equipped with a graphics subsystem with 512-MB of
discrete video memory

638854-001

For use only with computer models equipped with a graphics subsystem with UMA video memory

638856-001

For use only with computer models equipped with an Intel processor:
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For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory and NVIDIA GeForce GT 610M

681045-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory and NVIDIA GeForce GT 520M

676209-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory and supports bus alive/chip off (BACO)

650199-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics
subsystem with 512-MB of discrete video memory and supports bus alive/chip off (BACO)

650198-001

For use only with computer models equipped with the Intel HM55 chipset and a graphics
subsystem with 512-MB of discrete video memory

654117-001

For use only with computer models equipped with the Intel HM55 chipset and a graphics
subsystem with UMA video memory

654118-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
1024-MB of discrete video memory

636375-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
512-MB of discrete video memory

636374-001

For use only with computer models equipped with an HM55 chipset and a graphics subsystem with
1024-MB of discrete video memory

636372-001
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Description

Spare part number

For use only with computer models equipped with an HM55 chipset and a graphics subsystem with
512-MB of discrete video memory

636371-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
UMA video memory

636373-001

For use only with computer models equipped with an HM55 chipset and a graphics subsystem with
UMA video memory

636370-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 54)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:
●

Memory module (see Memory module on page 53)

●

RTC battery (see RTC battery on page 77)

●

Fan and heat sink (see Fan and heat sink on page 79)

●

Processor (see Processor on page 84)
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Remove the system board:
1.

Disconnect the following cables from the system board:
(1) LED board cable
(2) Speaker cable
(3) Optical drive cable
(4) Display panel cable

2.
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Disconnect the power connector cable (1) from the system board.
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3.

Release the ZIF connector to which the USB board cable is attached, and then disconnect
the USB cable (2) from the system board.

4.

Remove the Phillips PM2.5×6.0 screw (1) that secures the system board to the base enclosure.

5.

Lift the right side of the system board (2) until it rests at an angle.
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6.

Remove the system board (3) by sliding it up and to the right at an angle.

NOTE: System boards for use with computer models equipped with an AMD processor have
the Southbridge chip located on the bottom of the board. A thermal pad is used on
the Southbridge chip (1) and the base enclosure heat sink (2) that services it. The
thermal material must be thoroughly cleaned from the surfaces of the system board and the heat
sink attached to the base enclosure each time the system board is removed. Replacement
thermal material is included with all base enclosure and system board spare part kits.

Reverse this procedure to install the system board.

76

Chapter 4 Removal and replacement procedures

RTC battery
Description

Spare part number

RTC battery (includes cable and double-sided tape)

637193-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 54)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

●

System board (see System board on page 72)

Remove the RTC battery:
1.

Turn the system board upside down, with the front toward you.

2.

Disconnect the RTC battery cable (1) from the system board.
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3.

Remove the RTC battery (2) from the system board. (The RTC battery is attached to the system
board with double-sided tape.)

Reverse this procedure to install the RTC battery.
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Fan and heat sink
NOTE:

The fan and heat sink spare part kits include replacement thermal material.

Description

Spare part number

Fan

639460-001

Heat sink for use only with computer models equipped with an AMD processor:
For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with discrete video memory

649953-001

For use only with computer models equipped with the AMD A60M chipset and a graphics
subsystem with UMA video memory

649954-001

For use only with computer models equipped with the AMD RS880MD chipset and a graphics
subsystem with discrete video memory 649952-001

649952-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with discrete video memory

639462-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with UMA video memory

639463-001

Heat sink for use only with computer models equipped with an Intel processor:
For use only with computer models equipped with the Intel HM65 or HM55 chipset and a graphics
subsystem with discrete video memory

654119-001

For use only with computer models equipped with the Intel HM65 or HM55 chipset and a graphics
subsystem with UMA video memory

654120-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
discrete video memory

641141-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
UMA video memory

641140-001

For use only with computer models equipped with an HM55 chipset and a graphics subsystem with
discrete video memory

637190-001

For use only with computer models equipped with an HM55 chipset and a graphics subsystem with
UMA video memory

637189-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.
Before removing the fan and heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 54)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

●

System board (see System board on page 72)

Remove the fan and heat sink:
1.

Turn the system board upside down, with the front toward you.
NOTE: Steps 2 through 4 apply to computer models equipped with an AMD processor. See
steps 5 through 7 for heat sink removal information for computer models equipped
with an Intel processor.

2.

Disconnect the fan cable (1) from the system board.

3.

Remove the three Phillips PM2.5×5.0 screws (2) and the three Phillips PM2.5×10.0 springloaded screws (3) that secure the heat sink to the system board.
NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.

4.
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Remove the fan and heat sink (4).
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement
thermal material is included with the base enclosure, heat sink, processor, and system board
spare part kits.
●

Thermal paste is used on the processor (1) and the heat sink section (2) that services it

●

A thermal pad is used on the Northbridge chip (3) and the heat sink section (4) that
services it

●

A thermal pad is used on the graphics subsystem chip (5) and the heat sink section (6) that
services it (only on computer models equipped with a graphics subsystem with
discrete memory)

NOTE: Steps 5 through 7 apply to computer models equipped with an Intel processor. See
steps 2 through 4 for heat sink removal information for computer models equipped
with an AMD processor.
5.

Disconnect the fan cable (1) from the system board.
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6.

Remove the three Phillips PM2.5×5.0 screws (2) and the four Phillips PM2.5×10.0 spring-loaded
screws (3) that secure the heat sink to the system board.
NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.

7.

Remove the fan and heat sink (4).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement
thermal material is included with the base enclosure, heat sink, processor, and system board
spare part kits.
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●

Thermal paste is used on the processor (1) and the heat sink section (2) that services it

●

A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it (only on computer models equipped with a graphics subsystem with
discrete memory)
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1.

If it is necessary to replace the fan, turn the fan and heat sink upside down with the fan
toward you.

2.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the fan to the heat sink.

3.

Disengage the two clips (2) that secure the fan to the heat sink.

4.

Remove the heat sink (3) from the fan.

Reverse this procedure to reassemble and install the fan and heat sink.
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Processor
NOTE:
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The processor spare part kit includes replacement thermal material.

Description

Spare part number

AMD A8-3520M 2.50-GHz processor (1.6-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

669686-001

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

653350-001

AMD A6-3420M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

669688-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

653349-001

AMD A4-3320M 2.60-GHz processor (2.0-GHz FSB, 4.0-MB L2 cache, dual core, 35 W)

669690-001

AMD A4-3305M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 45 W)

672093-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W)

653348-001

AMD E2-3000M 2.40-GHz processor (1.8-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

653351-001 or
677628-001

AMD Athlon II P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/
sec, dual core, 25 W)

636635-001

AMD Athlon II P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/
sec, dual core, 25 W)

616343-001

AMD Phenom II N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, quad core, 35 W)

635496-001

AMD Phenom II N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

635495-001

AMD Phenom II N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

616345-001

AMD Phenom II N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, dual core, 35 W)

635494-001

AMD Phenom II P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/
sec, quad core, 25 W)

634689-001

AMD Phenom II P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

634688-001

AMD Phenom II P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25 W)

634687-001

AMD Turion II P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/
sec, dual core, 25 W)

634691-001

AMD V160 2.40-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W)

636634-001

AMD V140 2.30-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W)

616333-001

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (4-MB
L3 cache, dual core, 35 W)

666173-001

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4-MB
L3 cache, dual core, 35 W)

631252-001

Intel Core i5-480M 2.66-GHz (SC turbo up to 2.93-GHz) processor (3-MB
L3 cache, dual core, 35 W)

634693-001
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Description

Spare part number

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3-MB
L3 cache, dual core, 35 W)

631255-001

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3-MB
L3 cache, dual core, 35 W)

631253-001

Intel Core i5-2450M 2.50-GHz (SC turbo up to 3.10-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

676359-001

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

653341-001

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3-MB
L3 cache, dual core, 35 W)

638039-001

Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W)

677152-001

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653340-001

Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653339-001

Intel Core i3-390M 2.66-GHz processor (3-MB L3 cache, dual core, 35 W)

634692-001

Intel Core i3-380M 2.53-GHz processor (3-MB L3 cache, dual core, 35 W)

625823-001

Intel Core i3-2310M 2.10-GHz processor (3-MB L3 cache, dual core, 35 W)

638037-001

Intel Pentium B970 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W)

676785-001

Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W)

664662-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W)

653338-001

Intel Pentium B940 TJ85 2.00-GHz processor (2.0-MB L3 cache, dual core, 35 W)

653337-001

Intel Pentium P6300 2.26-GHz processor (3-MB L3 cache, dual core, 35 W)

635500-001

Intel Pentium P6200 2.13-GHz processor (3-MB L3 cache, dual core, 35 W)

625831-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 54)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)
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●

System board (see System board on page 72)

●

Heat sink (see Fan and heat sink on page 79)

Remove the processor:
1.

Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2), until you hear a click.

2.

Lift the processor (3) straight up, and remove it.
NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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LED board
Description

Spare part number

LED board

640293-001

Before removing the LED board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 54)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

●

System board (see System board on page 72)

Remove the LED board:
1.

Release the clips (1) built into the base enclosure that secure the LED board.

2.

Release the LED board cable (2) from the base enclosure. (The LED board cable is attached to
the base enclosure with double-sided tape.)
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3.

Remove the LED board and cable (3).

Reverse this procedure to install the LED board and cable.

Display assembly
NOTE: The display assembly spare part kit includes webcam, two microphones, and wireless
antenna transceivers and cables).
Description

Spare part number

14.0-in, HD, LED, BrightView display assembly
In butter gold finish

641343-001

In charcoal gray finish

641338-001

In luminous rose finish

641337-001

In ocean drive finish

639447-001

In Pacific blue finish

641340-001

In pearl pink finish

641341-001

In pewter finish

641339-001

In Sonoma red finish

641336-001

In sweet purple finish

641342-001

In Nero black finish

677167-001

Before removing the display assembly, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 48), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 54)

●

Keyboard (see Keyboard on page 56)

●

Top cover (see Top cover on page 59)

Remove the display assembly:
1.

Disconnect the display panel cable (1) from the system board.

2.

Release the wireless antenna cables (2) from the clips and the opening in the base enclosure.
CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

3.

Remove the four Phillips PM2.5×6.0 screws (3) that secure the display assembly to
the computer.

4.

Remove the display assembly (4).
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5.

6.

If it is necessary to replace the display bezel or any of the display assembly subcomponents:
a.

Remove the Mylar screw covers (1) and the two Phillips PM2.5×6.0 screws (2) that secure
the display bezel to the display assembly.

b.

Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

c.

Remove the display bezel (4). The display bezel is available using spare part number
639440-001.

If it is necessary to replace the webcam/microphone module:
a.
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Detach and release the webcam/microphone module (1) as far as the webcam/microphone
module cable allows. (The webcam/microphone module is attached to the display
enclosure with double-sided tape.)
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7.

b.

Disconnect the webcam/microphone module (2) from the webcam/microphone module.

c.

Remove the webcam/microphone module. The webcam/microphone module is available
using spare part number 637197-001.

If it is necessary to replace the hinge covers:
a.

Remove the Phillips PM2.5×6.0 (1) screws that secure the hinge covers to
the display enclosure.

b.

Remove the hinge covers (2). The hinge covers are available using spare part number
639446-001.
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8.
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If it is necessary to replace the display panel:
a.

Remove the four Phillips PM2.5×6.0 screws that secure the display panel to
the display enclosure.

b.

Lift the top edge of the display panel, and then swing it up and forward until it rests upside
down in front of the display enclosure.
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9.

c.

Release the adhesive strip (1) that secures the display panel cable to the display panel,
and then disconnect the display panel cable (2) from the display panel.

d.

Remove the display panel. The display panel cable is available using spare part number
639454-001.

If it is necessary to replace the display hinges:
a.

Remove the four Phillips PM2.0×3.0 screws (1) that secure the display hinges to
the display panel.

b.

Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 639445-001.
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10. If it is necessary to replace the display panel cable:
a.

Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.

b.

Release the display panel cable from the clips (2) built into the display enclosure.

c.

Remove the display panel cable (3). The display panel cable includes the webcam/
microphone module cable and is available in the Display Cable Kit, spare part number
639441-001.

11. If it is necessary to replace the wireless antenna cables and transceivers:
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a.

Release the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b.

Release the wireless antenna cables from the clips (2) built into the display enclosure.

c.

Remove the wireless antenna cables and transceivers (3). The wireless antenna cables
and transceivers are available in the Antenna Kit, spare part number 640294-001.
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Reverse this procedure to reassemble and install the display assembly.
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5

Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility
Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup
Utility includes settings for the types of peripherals installed, the startup sequence of the computer,
and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer
from operating properly.

Starting Setup Utility
NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only
if USB legacy support is enabled.
To start Setup Utility, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter Setup Utility.

Changing the language of Setup Utility
1.

Start Setup Utility.

2.

Use the arrow keys to select System Configuration > Language, and then press enter.

3.

Use the arrow keys to select a language, and then press enter.

4.

When a confirmation prompt with your language selected is displayed, press enter.

5.

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility
To navigate and select in Setup Utility, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of
the screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Setup Utility.
2.

Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:
●

To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

●

To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information
1.

Start Setup Utility.

2.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter Setup Utility.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility
●

To exit Setup Utility and save your changes from the current session:
If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Saving Changes, and then press enter.

●

To exit Setup Utility without saving your changes from the current session:
If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Setup Utility.
1.

Start Setup Utility.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using
the AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During
the download and installation, follow these instructions:
Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep or Hibernation.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Windows 7—Select Start > Help and Support > Maintain.
Windows XP—Select Start > Help and Support, and then select the software and drivers
update.

2.

Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3.

At the download area, follow these steps:
a.

Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.
NOTE: If you connect your computer to a network, consult the network administrator
before installing any software updates, especially system BIOS updates.

Using Setup Utility
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after
the download is complete. If no instructions are displayed, follow these steps:
1.

Windows 7—Open Windows Explorer by selecting Start > Computer.
Windows XP—Open Windows Explorer by selecting Start > My Computer.

2.

Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete
the downloaded file from your hard drive.

Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:
●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that
the start-up test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact
HP support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.
To start System Diagnostics:
1.

Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE:

If you need to stop a diagnostics test while it is running, press esc.
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6

Specifications

Computer specifications
Metric

U.S.

Width

34.1 cm

13.43 in

Depth

23.1 cm

9.10 in

Height (front to back)

3.0 cm to 3.6 cm

1.9 in to 1.4 in

Weight:

2.20 kg

4.9 lbs

Dimensions:

Input power
Operating voltage and current

18.5 V dc @ 3.5 A - 65 W or 19 V dc @ 4.74 A - 90 W

Temperature
Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 90%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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14.0-inch, display specifications
Metric

U.S.

Width

31.2 cm

12.28 in

Height

17.6 cm

6.93 in

Diagonal

35.7 cm

14.05 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

200 nits (typical)

Backlight

LED

Character display

80 × 25

Total power consumption

6.0 W

Viewing angle

+/-65 horizontal, +/-50° vertical (typical)

Dimensions
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Hard drive specifications
750-GB*

640-GB*

500-GB*

320-GB*

250-GB*

Height

9.5 mm

9.5 and 7.0
mm

9.5 mm

9.5 and 7.0
mm

7.0 mm

Width

70 mm

70 mm

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

ATA security

ATA security

Dimensions

Seek times (typical read, including setting)
Single track

3 ms

3 ms

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

24 ms

24 ms

Logical blocks

1,465,128,359

1,250,242,867

976,752,240

625,121.433

488,376,120

Disk rotational speed

5400 rpm

5400 rpm

7200 and
5400 rpm

7200 and
5400 rpm

7200 and
5400 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive
specifications
Applicable disc

Read:

Write:

BD-ROM, BD-ROM-DL, BD-R, BD-RDL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVDR, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and
mode 2), CDROM XA (mode 2, form 1
and form 2), Photo CD (single and
multiple sessions), CD Extra, CD-R,
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, DVD-R,
CDR, and CD-ROM

Access time

BD

DVD

Random

< 230 ms

< 180 ms

Cache buffer

4.5 MB

Data transfer rate
2X BD-RAM

9 MB/sec

8X DVD

2,400 KB/sec

16X CD-R

2,400 KB/sec

16X CD-RW

2,400 KB/sec
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DVD±RW and CD-RW Super Multi Double-Layer Combo
Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD, CDEXTRA, Portfolio, CD-R, CD-RW), CDR, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Cache buffer

2.5 MB

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode
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Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed. This chapter provides information on the following topics:
●

Creating a set of recovery discs or a recovery flash drive (Recovery Manager software feature)

●

Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

●

Backing up your information

●

Recovering a program or driver

Restore
In the event of hard drive failure, to restore your system to its factory image you will need a set of
recovery discs or a recovery flash drive that you can create using HP Recovery Manager. HP
recommends that you use this software to create either a set of recovery discs or a recovery flash
drive immediately after software setup.
If for some other reason you need to restore your system, this can be achieved using the HP
Recovery partition (select models only), without the need for recovery discs or a recovery flash drive.
To check for the presence of a recovery partition, click Start, right-click Computer, click Manage,
and then click Disk Management. If the recovery partition is present, a Recovery drive is listed in
the window.
CAUTION: HP Recovery Manager (partition, or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.
NOTE:

Recovery discs have been included if your computer does not have a recovery partition.
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Creating restore media
HP recommends that you create either a set of recovery discs or a recovery flash drive to be sure that
you can restore your computer to its original factory state if the hard drive fails, or if for any reason
you cannot restore using the recovery partition tools. Create these discs or the flash drive after setting
up the computer for the first time.
NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery
flash drive. Handle these discs or flash drive carefully and keep them in a safe place.
NOTE: If your computer does not include an integrated optical drive, you can use an optional
external optical drive (purchased separately) to create recovery discs, or you can purchase recovery
discs for your computer from the HP Web site. If you use an external optical drive, it must be
connected directly to a USB port on the computer, not to a USB port on an external device, such as a
USB hub.
Guidelines:
●

Purchase high-quality DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs.
NOTE: Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

●

The computer must be connected to AC power during this process.

●

Only one set of recovery discs or one recovery flash drive can be created per computer.
NOTE: If you are creating recovery discs, number each disc before inserting into the optical
drive.

●

If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open Recovery Manager, you will be prompted to
continue the backup creation process.

To create a set of recovery discs or a recovery flash drive:
1.

Select Start > All Programs > Recovery Manager > Recovery Media Creation.

2.

Follow the on-screen instructions.

Creating restore media 107

Performing a system restore
Recovery Manager software allows you to repair or restore the computer to its original factory state.
Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition (select models only) on the hard drive.
NOTE: A system restore needs to be performed if the computer hard drive has failed or if all
attempts to correct any functional computer issues fail.
A system restore should be used as a final attempt to correct computer issues. Note the following
when performing a system restore:
●

You can restore only the system that you have previously backed up. HP recommends that you
use HP Recovery Manager to create either a set of recovery discs or a recovery flash drive as
soon as you set up the computer.

●

Windows has its own built-in repair features, such as System Restore. If you have not already
tried these features, try them before using Recovery Manager.

●

Recovery Manager restores only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled
from the disc provided by the manufacturer.

Restoring using the dedicated recovery partition (select models only)
When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.
To restore the computer from the recovery partition, follow these steps:
1.

Access Recovery Manager in either of the following ways:
●

Select Start > All Programs > Recovery Manager > Recovery Manager.
– or –

●

Turn on or restart the computer, and then press esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen. Then, press f11 while
the “F11 (System Recovery)” message is displayed on the screen.

2.

Click System Recovery in the Recovery Manager window.

3.

Follow the on-screen instructions.
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Restoring using the restore media
1.

If possible, back up all personal files.

2.

Insert the first recovery disc into the optical drive on your computer or an optional external
optical drive, and then restart the computer.
– or –
Insert the recovery flash drive into a USB port on your computer, and then restart the computer.
NOTE: If the computer does not automatically restart in the Recovery Manager, the computer
boot order needs to be changed.

3.

Press f9 at system bootup.

4.

Select the optical drive or the flash drive.

5.

Follow the on-screen instructions.

Changing the computer boot order
To change the boot order for recovery discs:
1.

Restart the computer.

2.

Press esc while the computer is restarting, and then press f9 for boot options.

3.

Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:
1.

Insert the flash drive into a USB port.

2.

Restart the computer.

3.

Press esc while the computer is restarting, and then press f9 for boot options.

4.

Select the flash drive from the boot options window.
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Backing up and recovering your information
It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.
How completely you are able to recover your system depends on how recent your backup is.
NOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted. You can back up your information to an
optional external hard drive, a network drive, or discs.
Back up your system at the following times:
●

At regularly scheduled times
TIP: Set reminders to back up your information periodically.

●

Before the computer is repaired or restored

●

Before you add or modify hardware or software

Guidelines:
●

Create system restore points using the Windows System Restore feature, and periodically copy
them to an optical disc or an external hard drive. For more information on using system restore
points, refer to Using Windows system restore points.

●

Store personal files in the Documents library and back up this folder periodically.

●

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste. The screen image is added to
the document.

4.

Save and print the document.
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Using Windows Backup and Restore
Guidelines:
●

Be sure that the computer is connected to AC power before you start the backup process.

●

Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:
1.

Select Start > Control Panel > System and Security > Backup and Restore.

2.

Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Using Windows system restore points
A system restore point allows you to save and name a snapshot of your hard drive at a specific point
in time. You can then recover back to that point if you want to reverse subsequent changes.
NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created
since the last restore point.
You also can create additional restore points to provide increased protection for your files and
settings.

When to create restore points
●

Before you add or modify software or hardware

●

Periodically, whenever the computer is functioning optimally

NOTE:

If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point
1.

Select Start > Control Panel > System and Security > System.

2.

In the left pane, click System Protection.

3.

Click the System Protection tab.

4.

Follow the on-screen instructions.

Restore to a previous date and time
To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:
1.

Select Start > Control Panel > System and Security > System.

2.

In the left pane, click System Protection.

3.

Click the System Protection tab.

4.

Click System Restore.

5.

Follow the on-screen instructions.
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Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC
The 3-conductor power cord set included with the computer meets the requirements for use in
the country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

COC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzlerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with
the Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and
the backlight. When you remove these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.
This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel 3.

116 Chapter 9 Recycling

4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to
the display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.

118 Chapter 9 Recycling

15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.
17. Remove the backlight frame from the display panel.

WARNING! The backlight contains mercury. Exercise caution when removing and handling
the backlight to avoid damaging this component and causing exposure to the mercury.
18. Remove the backlight from the backlight frame.
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19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter light 16
AC adapter, spare part numbers
32, 34
action keys 11
antenna
locations 9
removal 94
spare part number 29, 37, 94
Antenna Kit, spare part number
29, 37, 94
audio, product description 6
audio-in jack 14
audio-out jack 14
B
base enclosure, spare part
number 26, 36
battery
removal 48
spare part numbers 26, 33, 48
battery bay 17
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Blu-ray ROM DVD±R/RW Super
Multi Double-Layer Drive
precautions 42
removal 49
spare part number 36
spare part numbers 26, 31,
40, 49
specifications 104
Bluetooth module
spare part numbers 33
Bluetooth module cable
spare part numbers 33
bottom components 17
button component 10
buttons
power 10

TouchPad 13
TouchPad on/off 13
C
Cable Kit
contents 28
spare part number 28, 36
Cable Kit,
spare part number 22
cables, service considerations 41
caps lock light 12
chipset, product description 3
components
bottom 17
button 10
display 9
front 15
keys 11
left side 14
lights 12
right side 16
TouchPad 13
computer feet
locations 47
spare part number 26, 37, 47
computer major components 20
computer specifications 101
connectors, service
considerations 41
D
Digital Media Slot 14
display assembly
removal 88
spare part numbers 21, 36,
37, 38, 88
subcomponents 29

display bezel
removal 90
spare part number 29, 36, 90
Display Cable Kit, spare part
number 29, 36, 94
display components 9
display enclosure, spare part
numbers 29, 36, 37
Display Hinge Kit, spare part
number 29, 36, 93
display panel
product description 5
removal 92
spare part number 29, 36, 93
display panel cable
removal 94
spare part number 29, 36, 94
Display Screw Kit, spare part
number 30, 37
display specifications 102
drive light 14
drives, preventing damage 42
DVD±RW and CD-RW Super Multi
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precautions 42
removal 49
spare part number 36
spare part numbers 26, 31,
40, 49
specifications 105
E
electrostatic discharge 42
equipment guidelines 45
esc key 11
Ethernet, product description 6
external media cards, product
description 6
external monitor port 14
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F
fan
removal 79
spare part number 25, 37, 79
feet
locations 47
spare part number 26, 37, 47
fn key 11
front components 15
G
graphics, product description
grounding guidelines 42
guidelines
equipment 45
grounding 42
packaging 44
transporting 44
workstation 44

3

H
hard drive
precautions 42
product description 5
removal 51
spare part numbers 26, 30,
36, 38, 51
specifications 103
hard drive bay 17
hard drive cable
illustrated 28
removal 52
Hard Drive Hardware Kit, spare
part number 26, 31, 36, 51
hard drive isolator
ilustrated 31
removal 52
hard drive shield, illustrated 31
HDMI port 14
headphone jack 14
heat sink
removal 79
spare part numbers 25, 37,
39, 40, 79
hinge
removal 93
spare part number 29, 36, 93
hinge cover
removal 91
spare part number 29, 36, 91
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K
key components 11
keyboard
product description 7
removal 56
spare part numbers 21, 35,
38, 56
keys
action 11
esc 11
fn 11
Windows application 11
Windows logo 11
L
LED board
removal 87
spare part number 26, 37, 87
left-side components 14
light components 12
lights
AC adapter 16
caps lock 12
drive 14
optical drive 16
power 12, 14
TouchPad 12, 13
webcam 9
wireless 12
M
mass storage device
precautions 42
removal 51
spare part numbers
memory module
product description
removal 53
spare part numbers
37, 53
microphone
location 9
product description
microphone jack 14
model name 1
monitor port 14
N
network jack 14

30, 51
5
26, 34,

6

O
operating system, product
description 8
optical drive
location 16
precautions 42
product description 5
removal 49
spare part numbers 26, 31,
36, 40, 49
specifications 104, 105
optical drive bay space saver,
spare part number 26, 31, 40,
49
optical drive bracket, removal 50
optical drive cable
illustrated 28
removal 68
optical drive light 16
P
packaging guidelines 44
plastic parts, service
considerations 41
Plastics Kit, spare part number
27, 36, 49
pointing device, product
description 7
ports, product description 7
power button 10
power button board
removal 63
spare part number 22, 36, 63
power connector 16
power connector cable
removal 71
spare part number 22, 36
power cord
set requirements 113
spare part numbers 32, 33
power light 12, 14
power requirements, product
description 7
processor
product description 1
removal 84
spare part numbers 23, 34,
35, 36, 39, 40, 84
product description
audio 6

chipset 3
display panel 5
Ethernet 6
external media cards 6
graphics 3
hard drives 5
keyboard 7
memory module 5
microphone 6
operating system 8
optical drive 5
pointing device 7
ports 7
power requirements 7
processors 1
product name 1
security 7
serviceability 8
video 6
wireless 6
product name 1
R
removal/replacement
preliminaries 41
procedures 46
right-side components 16
RJ-45 jack 14
RTC battery
removal 77
spare part number 23, 36, 77
Rubber Feet Kit, spare part
number 26, 37, 47
S
Screw Kit, spare part number 32,
37
security cable slot 16
security, product description 7
service considerations
cables 41
connectors 41
plastic parts 41
service cover
removal 49
spare part number 27, 49
service tag 19, 46
serviceability, product
description 8
Setup Utility (BIOS) 96

Speaker Kit, spare part number
22, 37, 67
speakers
location 15
removal 67
spare part number 22, 37, 67
specifications
Blu-ray ROM DVD±R/RW
Super Multi Double-Layer
Drive 104
computer 101
display 102
DVD±RW and CD-RW Super
Multi Double-Layer Combo
Drive 105
hard drive 103
optical drive 104, 105
system board
removal 72
spare part numbers 22, 35,
36, 38, 39, 72
system boards
spare part numbers 40
System Diagnostics 96
T
tools required 41
top cover
removal 59
spare part numbers 22, 37,
38, 59
TouchPad button 13
TouchPad button board
removal 64
spare part number 22, 36, 64
TouchPad cable
disconnection 61
illustrated 28
TouchPad components 13
TouchPad LED board
removal 65
spare part number 22, 37, 65
TouchPad light 12, 13
TouchPad on/off button 13
TouchPad zone 13
transporting guidelines 44

U
USB board
removal 70
spare part number 22, 36
USB port 14, 16
V
vent 14, 17
video, product description

6

W
webcam light 9
webcam, location 9
webcam/microphone module
removal 90
spare part number 29, 36, 91
Windows application key 11
Windows logo key 11
wireless antenna
locations 9
removal 94
spare part number 29, 37, 94
wireless light 12
wireless, product description 6
WLAN module
removal 54
spare part numbers 26, 33,
34, 37, 40, 54
workstation guidelines 44
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